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B
efore we get into how this book works, what it’s all about, and the boring stuff that usually winds up in

introductions, I want to say right up front that you’re going to have so much fun with this book,

you’re going to absolutely lose your mind.

I know it sounds crazy, but this book is going to change your life. Because after reading and applying the

techniques learned here, you’ll be able to walk in the door of virtually any secret underground religious cult,

and they’ll take you as a member—no questions asked, right on the spot. Not only that, you’ll put up little or

no resistance whatsoever when asked to sign over all your personal belongings, and you’ll willingly agree to

cut off all contact with your family and friends because after all, they no longer share your glorious dream of

becoming “one with the pixel.” They’re “outsiders,” “nonbelievers,” and therefore can’t be trusted.

What’s more amazing is that I was able to find both professional editors and a respected publisher to let me

start the introduction of my book with this whole “cult” thing. You know what that says to me? Even they don’t

read book introductions. But you, you’re different, you’re a rebel—someone who looks convention in the face

and then quickly looks away, so as not to be rude. You’re ready for a different kind of Photoshop book. An edgy

Photoshop book: A Photoshop book that takes risks—just like you.

You don’t want chapter after chapter waxing philosophical about resolution, color management, file formats

(and the women who love them). You don’t want lengthy technical explanations of how each tool mathemati-

cally interacts before you’re allowed to touch any of them. No, that’s not you. You’re alive. You’re unbound. You

want to do the cool stuff now! You want to sit down in front of your computer and the next time you look up,

it’s 4:15 in the morning—you’ve been up all night, and you don’t even care. Why? Because you’ve been having

a blast (and because you’re going to bill your client for every minute). When your client gets the invoice, there’s

a reasonable chance they’ll black out, perhaps more than once, but it’ll all be worth it when they see your work.

That’s what this book is all about—teaching you the coolest special effects that will blow your clients away,

make you truckloads of money, and give you the most fun you’ve ever had using Photoshop—without all the

boring technical stuff.

If this is who you are. If this is who you want to be. This, my friend, is the book for you. Embrace it. Feel it.

Feed it (feed it?). But what if this isn’t who you are, and not who you want to be? Buy this book anyway. It’s

good for the economy.

How this book works

Think of this as a “Photoshop special effects cookbook.” Need to create a studio backdrop for a product

shot? Turn to page 177. Need a cool chrome effect for an ad? Turn to page 104. Need to do cool stuff

right now, for a project due tomorrow? Just turn to the page that has the effect you need, and follow the

step-by-step instructions.

You’ll be able to re-create every technique in this book, regardless of your level of Photoshop experience,

and you’ll unlock the secrets for creating today’s hottest Photoshop effects—the same ones you see in national

magazines, on TV, and on the Web that would otherwise have taken years to learn, but are simple—once you

know the secrets. You’ll be absolutely amazed at how easy these tricks really are, and they’re all here, including

those closely guarded “insider tips” and down and dirty tricks of the trade. There are no years of study, no

complex mathematical concepts to master, no baloney. It’s (as we say) “Just the funk and not the junk!”

I N T R O D U C T I O N
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Okay, so now you know what the book is all about—special effects and cool tricks—but you probably have

other questions. Probing, lingering personal questions whose answers may be too uncomfortable for our studio

audience, so instead I thought we’d do something safer—a simple Q&A section where I make up the questions

I’d like to have answered if I was the person buying this book, and then I answer them, as if I’d written the book

(which coincidentally, I did). If this sounds at all confusing, it should. Here we go:

Q. Where should I start in the book?

A. Honestly, it doesn’t matter. This book isn’t designed to be read like a novel, starting with chapter 1, then

chapter 2, etc.—this is a jump-in-anywhere book and start “effecting.” To learn a little bit more about what’s

in each chapter, make sure you read the chapter intros. I say “a little” more, because I wrote those at about

2:00 a.m., and I was half in the bag (I mean, quite tired after many hours of work). Also, if you’re a seasoned

Photoshop user, don’t be put off because I give full explanations of steps in the tutorials. For example, instead

of just saying “Create a new layer” I generally say “Create a new layer by clicking on the New Layer icon at the

bottom of the Layers palette.” I do that because I want any user, at any level of Photoshop experience, to be able

to jump in any place in the book and pull off the technique. There’s no “intro to Photoshop” chapter—I figured

if you bought this book, instead of one of those 1,000-page “learn everything about Photoshop” books, you

want to do the cool stuff now, so I start on page 1 with the first special effect and I don’t stop again until the

back cover. (Okay, they made me put an index in the back, but wouldn’t you really rather have had another

special effect instead? Come on, admit it. See, I knew this book was for you!)

Q. How is this book different from your 6.0 book?

A. This book is better (you knew I was going to say that. Heck, even I knew that you knew that I was going to

say that). In fact, not even taking into account all the new Photoshop 7 stuff, I think it’s a much better book.

It’s yummier, cooler, rockin’-er—anything good you can think of ending with an “-er.” That’s what this book is.

I’ve learned a lot of slick, new effects since I wrote the last version of this book, and I’ve been fortunate enough

to have Photoshop users all over the world send me some of their favorite tips and techniques as well, so there’s

a lot of brand-new stuff in this book. But...I also updated some of the most popular effects from the 6.0 version

of the book as well. In many cases, I’ve found easier ways to do them, interesting new ways to use them, some

little shortcuts that make them more fun, and basically I just can’t stop trying to find ways to make them even

better. It’s a sickness.

Q. Where do all these cool effects come from?

A. France.

Q. No, really, where do they come from?

A. Actually, the book is a combination of a lot of different things. The whole “Down & Dirty” concept started

back in 1993 with a session I did called “Photoshop Down & Dirty Tricks” at a Photoshop seminar held in Ft.

Lauderdale, Florida. It turned out to be the hit of the seminar, and I think the reason it resonated with the

crowd was that I was teaching them the exact same things I’d been trying so hard to learn just a few months

I N T R O D U C T I O N  ( c o n t i n u e d )
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earlier. At the time, I had my own “wish list” of Photoshop effects that I wanted to learn, and once I learned

them, I couldn’t wait to share them with other Photoshop users. We had fun that day. We laughed, we cried

(okay, I cried), we learned, and at the end of the day, I don’t know who was more excited, the attendees or

me, but I knew then that this is what I wanted to do.

It’s nine years later and I still do a constantly updated version of the “Photoshop Down & Dirty Tricks”

session live at the Adobe Photoshop Seminar Tour as well as at PhotoshopWorld. Out of those sessions came

my best-selling Photoshop “Down & Dirty Tricks” video series, and some of my favorite techniques from

there are here too. I also included techniques from the “Down & Dirty Tricks” column that I write with Felix

Nelson in Photoshop User magazine, and I included lots of new Down & Dirty Tricks that I’ve never done

anywhere else. In short, this book takes some of my favorite Photoshop techniques and combines them all

into one resource. It’s the book that I wish I’d found when I was trying to learn these types of effects, and I’m

thrilled to be able to bring this new updated version to you.

Actually, finding ideas for new Photoshop effects is easy because Photoshop is literally everywhere. Open

a magazine, look at TV, or just drive down the street and look at the billboards—you’re looking at

Photoshop work. There are two things about that reality that I truly love: (1) figuring out how they did those

effects, and (2) sharing how they did them with other people like yourself. It’s how I get my kicks. That, and

doing crack—kidding (you knew that, right?).

Q. This book has lots of cool images, do I get those too?

A. You’re kinda greedy, aren’t you? Okay, you can have the images. Here’s the scoop: When I was preparing to

write this new version of the book, as you might imagine, I wanted it to have great-looking images, and that’s

why I asked Digital Vision if I could use their royalty-free stock images in the book. I honestly feel that they

have the hottest royalty-free images in the market today and that’s why I contacted them, and only them, to

arrange to use their images.

Luckily, besides having the hottest images, they’re incredibly nice people and I was able to use that to

guilt them into letting you download the images used in the book from the book’s companion Web site at

www.downanddirtytricks.com. How cool are Digital Visions images? Why don’t you see for yourself at

www.digitalvisiononline.com? In particular, make sure you check out their Infinity collection to see some of

the hottest, cutting-edge work from Europe’s smartest young designers. Yes, that’s totally a plug, but they

didn’t ask me to do it. (If they had, I would have, but they didn’t.)

Now, you may also notice that there are some photos in the book that are, well…not quite as good as

others. For example, there’s a head shot of Felix taken outside our offices. Believe it or not, that’s not a

royalty-free image from Digital Vision (although it certainly should be). In certain cases, we took some

snapshots using our trusty (rusty? crusty?) digital camera, so any photo that doesn’t look really slick is

probably one of those—and not from Digital Vision. We let you download those photos as well. Please be

kind to them (i.e., don’t use Liquify on them)...especially the one of Felix.

I wanted any
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Photoshop

experience, to
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in at any place

in the book

and pull off

the technique.
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Q. Okay, who is Felix?

A. Felix Nelson is about the coolest, most creative, Photoshop guy in the world. He’s the  Creative Director

for Photoshop User, and Art Director for Mac Design Magazine, and he has an amazing ability to do things

in Photoshop that I can’t even begin to understand. I’m fortunate  to work with Felix every day and I have

to honestly say that I learn more about Photoshop from Felix than from anyone else on the planet, and I’m

delighted to pass on some of his ideas and techniques throughout the book.

Q. Is this for Mac, Windows, or both?

A. Both! It covers the Macintosh and PC versions of Photoshop. (Honestly, it was pretty easy because

Photoshop is identical on both the Macintosh and PC platforms.) However, even though the software is the

same, the Mac and PC keyboards are slightly different so every time I give a keyboard shortcut in the book,

I give both Mac and PC keyboard shortcuts...see, I care.

Q. What are in those sidebars on every page?

A. In the previous version of this book, I put a Photoshop tip on every page. Some were little shortcuts, some

were timesavers, some were just advice (stocks, mutual funds, relationships, etc.), and as best as I can tell—

nobody really noticed. Everybody got sucked into all the cool special effects and figured the sidebars hid all

the boring technical stuff, instead of cool tips. So when I started updating the book, my first thought was to

pull out all the tips because, frankly, it’s hard coming up with almost 300 tips. But when Felix heard I was

taking out the tips, he started whining, “Ahhh man, you can’t take those out—I thought that was the coolest

part—it’s a special effects book, but it also had hundreds of sidebar tips.” So, I left ’em in, added some new

ones for Photoshop 7, and replaced any lame ones. I’m counting on you to do your part and read at least

some of them. I even added the header, “Quick Tip,” to each one hoping they’d catch your attention. These

are the acts of a desperate tips man.

Q. What if I’m still using Photoshop 6?

A. Well, then it’s time to upgrade—big time—because honestly, Photoshop 7 blows Photoshop 6 out of the

water, especially if you’re a photographer. In the meantime, if you still have 6, you can use this book and get

a lot out of it until you do upgrade (which, incidentally,  you should do tonight).

So why is it that a Photoshop 6 user would use this Photoshop 7 book? It’s because a lot of the things

Adobe added to Photoshop 7 weren’t special effects-related. For example, there aren’t many cool effects you

can do with the spell checker. I love the spell checker; I crave the spell checker. Apparently, I desperately need

a spell checker, but I can’t teach you really cool smoke effects, flames, or chrome effects with the spell

checker—sad, but true. Photoshop 7 was a major productivity upgrade, with cool stuff like the File Browser

(great for photographers, but again, makes for a lame special effect), the absolutely amazing Healing Brush

(the best tool for photo retouching ever, but as a special effects tool, it’s no drop shadow), Mac OS X and

Windows XP Support (again, no glass, no metal, no flames) and the hundred or so other tweaks, fixes, new

features, improvements, and enhancements that make it the best overall Photoshop ever. That’s why I

included lots of sidebar tips on cool new stuff in Photoshop 7 throughout the book, and of course, the

I N T R O D U C T I O N  ( c o n t i n u e d )
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tutorials in the whole book were done using Photoshop 7 (hence the book’s name). Now, what if you’re

using Photoshop 5.5 or 5.0? Don’t tell anyone, just hide yourself away in a tower somewhere until you can

upgrade to Photoshop 7.

Q. Blah, blah, blah. Enough already, eh?

A. You’re right, I’ve said enough. You’re now ready to enter a world of special effects delights that dare not

speak its name. A world where drop shadows intermingle with bevels amidst a starry sky created entirely

with the Noise filter and a tasteful hint of Gaussian Blur. This is your world. This is your time. Launch

Photoshop, go forth, and make cool stuff that will generate client invoices so large it would make a govern-

ment military contractor blush.

Q. What’s the Web site again?

A. The book’s companion Web site is at www.downanddirtytricks.com. It’s where you can download

the images used in the book, and if you go there, it will save me the trouble of publicly plugging my other

books, including Photoshop Photo-Retouching Secrets and Photoshop Killer Tips (I couldn’t help myself), now

quick, turn the page before I plug again...

Have fun kids, and don’t stay up too late.

5
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Full Metal Jacket
Metal and Chrome Effects

If you were one of those people who

bought previous versions of this

book (I call these people “my very best

friends in the whole wide world”), then

you’ll probably remember its chrome

chapter. (I did ask you to commit

the entire chapter to memory, didn’t I?)

Well, this chapter is vastly different. It’s

much “chromier,” “metallic-er” and even a

bit “goldified.” If you take the time to learn

the techniques in this chapter, and one day

you get a call from Snoop Doggy Dogg to

design the logo for his new CD, you’ll have

paid for the cost of this book many times

over, and before you know it, it’ll be “raining

Benjamins.” This works equally well if

someone like…say, General Motors calls to

have you design a new GM logo (the

current form of which features the tasteful

use of chrome around the edges). If that

should happen, you’ll probably be taking a

limo to work from now on. Now, what

happens if, instead of General Motors

calling, it turns out to be General Mills? Then

turn to my chapter on Photoshop Cereal

Design.  I think it starts on page 322.
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104 Photoshop 7 Down & Dirty Tricks

STEP ONE: Create a new blank
document in RGB mode. Set
black as your Foreground
color by pressing the letter “d”,
then create some type (in this
example, we used the Rapier
font). This effect is designed
for very large display-sized
type (such as 220 points or
more), so make sure your type
is fairly big. Go to the Layers
palette and at the bottom of
the palette, choose Satin from
the Layer Styles pop-up menu.

Cover Chrome

STEP TWO: When the dialog
box appears, change the
Blend Mode to Screen, click
on the black Color Swatch,
and change the color to white.
Increase the Distance to 14
and lower the Size to 7. Turn
on the Anti-aliased checkbox
and leave the default Contour
as is. Don’t click OK yet. In the
list of Styles in the left-hand
side of the Layer Styles dialog
box, click on the name Bevel
and Emboss.

This version of chrome uses nothing but Photoshop’s built-in Layer Styles, and I call it “Cover

Chrome” because it’s the basis of the chrome effect we used on the cover (actually it’s based on

Option #2 at the end of this tutorial). I know, the name “Cover Chrome” is pretty lame, but

hey…I needed a name for this effect and all the good chrome names had already been taken.
On the third page of this

chrome tutorial, I give you

two different options for

effects. (The second one

is what we used on the

cover for the word “Dirty,”

but we added some bolts

on top of the chrome,

as any self-respecting

"Photoshop-er" might

do.) If you like to experi-

ment and create options

of your own, changing

the current contour of

your Bevel and Emboss,

or Satin effect, is a great

way to tweak an existing

effect and give it a totally

different look. Just

double-click on the

effect, then click the

down-facing triangle next

to the current Contour

thumbnail. A library of

contours will appear, and

you can just start clicking

on each contour until you

see an effect you really

like. It sounds simple,

and it is.

Quick Tip:
Change contours
for a new effect
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A trick for quickly

changing your unit of

measure (say, from inches

to pixels) is to open the

Info palette and click on

the little crosshairs in the

lower left-hand corner

of the palette. A pop-up

list of measurement units

will appear, and you can

choose the one you want

directly from there.

Quick Tip:
Changing
your units of
measurement

STEP THREE: In the Bevel
and Emboss dialog, increase
the Depth to 271%. Under
the Shading section, set the
Altitude to 30°. Click on the
down-facing triangle next to
Gloss Contour and choose the
default contour that looks like
one hill (as shown). Change
the Highlight mode to Normal
and increase the highlight
Opacity to 100%. Change the
Shadow mode to Normal,
decrease the Opacity to 55%,
and change the shadow color
to white. Don’t click OK yet.

STEP FOUR: In the list of styles
in the left-hand side of the
Layer Styles dialog box, click
on the name Drop Shadow
to make its options visible.
Lower the Opacity to 50%
and increase the size to 8.

continued
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OPTION 1: In the Layers
palette, double-click on
the Satin effect to bring
up its options. Click on the
down-facing triangle next
to Gloss Contour and when
the Contour Picker appears,
click on the last of the
default contours (it looks
like two upward-facing
triangles, as shown). This
gives a brighter, more
detailed chrome with inset
lines that looks pretty sweet!

STEP FIVE: Click OK to apply
your combination of Layer
Styles to produce the effect
you see (right). That completes
the effect, but since we’ve
come this far, there are a
couple of minor things you
can change that will give you
an entirely different effect, so
I thought I’d throw those in as
well. Rather than calling them
Steps Six and Seven, because
they’re not really steps, we’ll
call them Option 1 and (you
guessed it) Option 2.

OPTION 2: If you’ve already
created Option 1, then you
can add this on top to create
another nice metallic twist.
This time in the Layers palette,
double-click on the Bevel and
Emboss effect to bring up its
options. Click on the down-
facing triangle next to Gloss
Contour and when the Contour
Picker appears, choose the
one with one hill, and this
gives you yet another version
 to choose from.

Photoshop allows you

to create a hard-edged

chisel effect via the Bevel

and Emboss Layer Effects

by changing the Tech-

nique to Chisel Hard.

Another way to create

a hard-edged chisel effect

is to use Alien Skin’s Inner

Bevel plug-in from their

Eye Candy collection of

Photoshop plug-in filters.

For more information

on their way-crazy, cool

plug-ins, visit them at

www.alienskin.com.

Quick Tip:
High-powered
chiseling

www.alienskin.com
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When you select the

Gradient tool, the Options

Bar immediately displays

the Gradient tool options.

If you click on the down-

facing triangle immedi-

ately to the right of the

Gradient thumbnail of

your currently selected

gradient, a flyout Gradient

Picker will appear with all

the gradient presets you

have loaded. Now, how

do you know which one

is the Chrome gradient?

Well, if you have the Tool

Tips preference turned

on (it’s on by default), just

hold your cursor over

any gradient swatch and

its name will appear. If

you’ve turned off Tool

Tips (frankly, they drive

me crazy, except for

finding gradients), then

you can choose to view

your gradients by name

rather than by thumb-

nails. You do that by

clicking on the right-

facing triangle in the

Gradient Picker to display

a pop-up menu where

you can choose Text

Only to display the

gradients by name.

This makes finding the

Chrome gradient a snap.

Quick Tip:
How to find the
Chrome gradient

White Chrome
This is a quick Type effect that uses a combination of three Layer Effects to create 95% of it and at

the end, we add a quick Curve and Hue/Saturation adjustment just for kicks. You don’t need to add

the Curve, but honestly, what you’re going to do using Curves is so easy that even if you’ve never

tried Curves before, you’ll be able to do this.

STEP ONE: Set some display
type at a very large point size
(this technique is designed
to be used only on very large
type. In the example shown
here, we used the font ITC
Styleboy set at 350 points
in a 12x6" document set to
low-res at 72 ppi).

STEP THREE: This time from
the Layer Style pop-up
menu,  choose Inner Shadow.
When the dialog box appears,
increase the Size to 13 to apply
a shadow on the inside
of your type. Don’t click OK yet.

STEP TWO: After your type is
set, choose Drop Shadow from
the Layer Styles pop-up menu
at the bottom of the Layers
palette. Set the Distance to 9,
Size to 13, and click OK to apply
a drop shadow to your black
type. Press “d” then “x” to set
your Foreground color to white,
then press Option-Delete
(PC: Alt-Backspace) to fill
your type with white, leaving
only the drop shadow visible
(as shown).

continued
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STEP FOUR: From the list of
Styles on the left side of the
Layer Styles dialog box, click
directly on the word Satin to
make its options visible. Lower
the Distance setting to 4 and
the Size setting to 5, then click
on the down-facing triangle
next to the Contour setting to
bring up the Contour Picker.
Choose the contour (from the
default set) that has two steep
hills. Then turn on the Anti-
aliasing checkbox, and turn off
the Invert checkbox. Now, you
can click OK, and both effects
will be applied to your type.

STEP FIVE:  Just applying those
three effects gives you a pretty
good-looking white chrome
effect and you can stop this
technique here and use the
type as is. However, I’m going
to take it a step further by
adding some color. Again, this
is totally optional. We’ll start by
choosing a Hue/Saturation
Adjustment Layer from the
Adjustment Layer pop-up
menu at the bottom of the
Layers palette (as shown).

STEP SIX: When the Hue/

Saturation dialog box appears,

click on the Colorize checkbox,

increase the Hue to 232,

decrease the Saturation to 22,

and then click OK to apply a

blue tint to your chrome. You’ll

also see an Adjustment Layer

added to your Layers palette

(which is handy in case you

want to edit this color later—

you can just double-click on

the Adjustment Layer and it

will bring up the Hue/Satura-

tion dialog box with the

previous settings you applied).

If you do much collaging

of images, this tip will save

you boatloads of time

(meaning a cargo bay of

cheap watches). To create

a new document with

the same size, resolution,

and color mode as your

current document, go

under the File menu

and choose New. While

the New dialog box is

onscreen, go under the

Window menu, under

Documents. There you’ll

see a list of all your

currently open docu-

ments. Choose the one

you want, and Photoshop

will automatically load its

size, resolution, and color

mode into your open

“New” dialog box. All you

have to do is click OK.

Quick Tip :
Creating another
document with
the same exact
specs as your
current document
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STEP SEVEN: Choose a Curves

Adjustment Layer from the

pop-up menu at the bottom of

the Layers palette. When the

Curves dialog box appears,

create the Curve shown left by

clicking once on the left side of

the curve line (which adds a

point) and then dragging that

point upward to form the first

“hill”.  Then click at the top of

the Curve to add a point and

drag that one down. Lastly, add

one more point to the right

and drag it upward, re-creating

the curve shown, then click OK.

STEP EIGHT:  Hide the

Background layer from view

by clicking on the Eye icon in

the first column to the left of

the Background layer. Go

under the Layers palette’s

drop-down menu and choose

Merge Visible to merge all

these layers into one. Now

you can make the Back-

ground layer visible again

to complete the effect

(shown below).

In the project shown here,

we’re using Adjustment

Layers and I have to tell

you that Adjustment

layers freak people out.

They shouldn’t, but they

do. However, if you know a

little  history about them,

they’re not only easier

to understand but it may

also encourage you to use

them as well.

Adjustment Layers

were introduced back in

Photoshop 4.0 (which

was 14 years before Ben

Franklin discovered

electricity), and back then

Photoshop didn’t have

multiple undos like we do

today. So, Adobe came

up with Adjustment Layers

as a way to give users an

“undo” for tonal adjust-

ments such as Curves,

Levels, Color Balance, etc.

When you applied one

of these, they appeared

in your Layers palette as

an Adjustment Layer. This

was great because,

if after working on a file

for several hours you

suddenly decided that you

wanted to undo that tonal

adjustment you made

hours earlier, you could

just drag that layer into

the Trash and it would

undo. Better yet, you could

save Adjustment Layers

with your file for undos at

a later date.

Quick Tip:
The advantage of
Adjustment Layers
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STEP ONE: Open a new

document in RGB mode. Make

light gray your Foreground

color. Create your type (you’ll

need to use very large type for

this effect; ideally, 200-point or

more). I used the Webdings

typeface at 300 points.

Ultimate Chrome

STEP TWO: Rasterize this Type

layer by going to the Layers

palette and Control-clicking

(PC: Right-clicking) on the Type

layer and from the pop-up

menu that appears, choose

Rasterize Layer. At the bottom

of the Layers palette, choose

Bevel and Emboss from the

Styles pop-up menu. When

the dialog box appears, you can

use the default settings, so just

click OK.

This is a chrome technique that I learned from Photoshop User magazine’s original creative

director. It’s based on a cover design he did for the magazine, but he created the original cover

using Photoshop 5.5, and since then we’ve found even easier ways to create the same effect using

Photoshop 7’s features.
In a number of places in

this book I mention that

you need to create the

effect at a large size. For

example, if it’s a Type

effect, I might tell you to

create the effect at 200- or

300-point size so the

effect looks right. But

don’t let that tie your

hands if you need to use

that big effect at a small

size—just create it at the

larger size, then use either

the Image Size command,

or Free Transform to scale

it down to the size you

really need later. The

effect will usually hold

when scaled down but if

you start at that smaller

size, oftentimes the effect

won’t look right, so you’re

better off to start off

big, and shrink it down

later. This is a very

common technique with

pro Web designers.

Quick Tip:
Using big effects
at small sizes
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STEP THREE: We’re going to

remove the Layer Style from

this layer, while leaving the

bevel still applied. To do this ,

create a new blank layer by

clicking on the New Layer icon

at the bottom of the Layers

palette, and then drag this

blank layer below your Type

layer; but then click back on

your Type layer (as shown in

Figure A). Press Command-E

(PC: Control-E) to merge these

two layers together (as shown

in  Figure B).

STEP FOUR: Press the letter “m”

to switch to the Rectangular

Marquee tool. Draw a series of

rectangular selections across

your text. Start by drawing one,

then hold the Shift key to add

other rectanglar selections.

Vary the height of each

selection (as shown at left). Go

under the Select menu and

choose Feather. Enter 5 pixels

for low-res, 72-ppi images or 20

pixels for 300-ppi, high-res

images, and click OK.

One of the downsides of

the feathering feature is

that you can’t see how

much you’re really

feathering; it’s pretty

much a guess because

there’s no preview. Here’s

a cool trick that many

people use to see a

feathered edge effect

before they apply it: First,

make a selection (inside

the edges of your image)

and then press the letter

“q” to enter Quick Mask

mode (your selection will

appear as a red box by

default). Go under the

Filter menu, under Blur,

and choose Gaussian Blur.

When you apply the blur,

you’ll see the edges

become very soft. When

the softness of the edges

looks right, press the

letter “q” again to return

to Normal mode and

make your selection

active. Go under the

Select menu and choose

Inverse to choose the

background edges, rather

than the inside of your

selection, and press

Delete (PC: Backspace)

to feather the edges

softly at the exact

amount you saw in the

Quick Mask preview.

Quick Tip:
How to see
feathering before
you apply it

STEP FIVE: Press Command-L

(PC: Control-L) to bring up the

Levels dialog box. Grab the

bottom right Output Levels

slider and drag it all the way

over to the left until the

readout shows 65, and then

click OK.

Figure A Figure B

continued
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STEP SIX: Press the Down

Arrow key on your keyboard

eight times to move the

selection downward. Then

press Command-I (PC:

Control-I) to invert the

selection.  Press Command-L

(PC: Control-L) to bring up

Levels again. Grab the TOP

right Input Levels slider, and

drag it over to the left until

the readout up top shows 140,

and then click OK.

STEP SEVEN: Your image

should look like the one

shown here. Deselect

by pressing Command-D

(PC: Control-D).

STEP EIGHT: At the bottom

of the Layers palette, choose

Bevel and Emboss from the

Styles pop-up menu. When the

dialog box appears, increase

the Depth to 200% and the

Size to 7 (for high-res images,

increase the Depth to 800%

and the Size to 25), click OK

to apply another bevel to

your image.

Quick Tip:
Crop and
straighten at
the same time
When you’re using the

Crop tool, you can

rotate your selected

area before you crop

by moving your pointer

outside the bounding

box that appears

around your image

where you dragged

the Crop tool. You’ll

see that your pointer

temporarily changes

into a double-headed

arrow, which enables

you to freely rotate

your object. When it’s

rotated just the way

you like it, you have

two choices: Double-

click inside the

bounding box or press

Return (PC: Enter) to

make the rotation

permanent. If you're

using the Crop tool and

you decide that you

don’t want to crop the

image after all, click

once on the Crop tool

icon in the Toolbox. A

dialog box will appear

giving you the option

to Crop or Don’t Crop.
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STEP NINE: Again we’re going

to remove the Layer Style

from the layer. Create a new

blank layer, and drag this blank

layer below your Type layer.

Click on your type layer,

then press Command-E

(PC: Control-E) to merge these

two layers together.

STEP TEN: Press Command-M

(PC: Control-M) to bring up the

Curves dialog box. You’ll see a

straight line (the curve) at a

45° angle. Click once about

25% from the bottom left to

add a point, and drag it

upward (you’re going to add

four points to create the curve

shown here). When your curve

looks like this, click OK.

STEP ELEVEN: Lastly, add a

Drop Shadow from the Layer

palette’s Layer Style pop-up

menu. Increase the Size to 18

pixels (40 for high-res, 300-ppi

images), and then apply the

Unsharp Mask filter (found

under the Filter menu, under

Sharpen) with the Amount set

at 100%, Radius  at 1, and

Threshold at 5, to complete

the effect.

First off, I had to say

“heck,” because there

could be kids reading this

book—and some of them

might be really smart

toddlers, so you can never

be too careful. One thing

I’ve found, and that you

might find helpful is that

when you have a chrome

or metallic image, you can

apply the Unsharp Mask

filter with very high

settings for Amount

settings (such as 300 to

500) and it looks just fine.

In fact, sometimes I’ll

apply Unsharp Mask to

chrome type three or four

times in a row (with

Amount settings around

100 to 150). Those hard

edges just soak up the

sharpening.

The main things you

need to look out for are

halos or weird unwanted

colors that can start to

creep into your edges.

Otherwise, sharpen till the

cows come home (if you

don’t have cows, just keep

sharpening until someone

yells, “Stop!” ).

Quick Tip:
If it’s metal,
sharpen the living
heck out of it
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Chrome Double Stroke Effect
I first saw this effect in a print ad for “Cocky,” the  album from hip-hop and rock rapper Kid Rock.

I loved the effect of having one stroke layered on top of another with chrome contours on both

strokes. It makes use of Bevel and Emboss contours, and it’s actually pretty simple to pull off.

STEP ONE: Create a new
document in RGB mode at 72
ppi. Press the letter “d” to set
your Foreground color to black,
then set some type at a very
large point size (in the example
shown here, I used the font
Aachen Bold set at 80 points,
and I increased the width in
the Character palette to 130%).

STEP TWO: From the Layer
Styles pop-up menu at the
bottom of the Layers palette,
choose Inner Shadow. When the
dialog box appears, lower the
Opacity to 40%, increase the
Size setting to 10, and click OK
to apply a soft shadow on the
inside of your type. When you
click OK, you won’t see the
shadow yet because your type
is black.

STEP THREE: Press the letter “x”
to change your Foreground
color to white. Press Option-
Delete (PC: Alt-Backspace) to fill
your type with white. Now you
should see the inner shadow
you created in the previous
step (as shown at right).

The type of effect shown

at right is often accented

with “glints” (little sparkles

of light). Check out page

153 for one technique for

adding glints to your

images.

Quick Tip:
Adding glints
to chrome
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STEP FOUR: Go to the Layers
palette and Command-click
(PC: Control-click) on your
Type layer’s name to put a
selection around your type.
While your selection is in
place, add a new blank layer
above your type layer by
clicking on the New Layer
icon at the bottom of the
Layers palette.

STEP FIVE: Go under the
Edit menu and choose Stroke.
When the dialog box appears,
click on the Color Swatch
and change your stroke color
to gray. For Width enter
4 pixels, for Location choose
Outside, and then click OK
to put a gray stroke around
your selection. Don’t Deselect
yet. From the Layer Style pop-
up menu (at the bottom of the
Layers palette), choose Bevel
and Emboss.

STEP SIX: When the dialog
box appears, change the
Technique to Chisel Hard.
Increase the Depth to 231%
and increase the size to 27.
In the Shading section, click
on the down-facing triangle
next to Gloss Contour. In
the default set of contours,
choose the second contour
on the second row (it’s named
Ring) as shown at left. Then,
click on the Anti-aliased
checkbox to smooth the
contour. Change the Shadow
mode from Multiply to
Lighten, then click OK to
apply this effect to your
stroked layer.

Here are some quick

shortcuts that can be

real timesavers for filling

selections or layers.

For example:

• To fill an entire layer

with your Foreground

color, press Option-Delete

(PC: Alt-Backspace).

• To fill just an object on a

layer (not the entire layer),

press Shift-Option-Delete

(PC: Shift-Alt-Backspace).

• To fill with your Back-

ground color, press

Command-Delete

(PC: Control-Backspace).

• To fill your layer with

black, press the letter “d,”

then Option-Delete

(PC: Alt-Backspace).

• To fill your layer with

white, press the letter “d,”

then the letter “x,” then

press Option-Delete

(PC: Alt-Backspace).

Quick Tip:
Fill shortcuts

continued
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STEP SEVEN: Since you haven’t
deselected, your selection
should still be in place. Go
under the Select menu, under
Modify, and choose Expand.
When the Expand dialog
box appears, enter 4 and click
OK to expand your selection
by 4 pixels.

STEP EIGHT: Go under the
Edit menu and choose Stroke.
When the dialog box appears,
your previous setting should
still be in place, so just click
OK to put a gray stroke around
your expanded selection.

STEP NINE: Since you applied
this stroke to the same layer
that you beveled earlier, this
new stroke is automatically
beveled, and the contour you
applied gives it a chrome look.
To complete the effect, simply
Deselect by pressing
Command-D (PC: Control-D),
then switch to the Back-
ground layer, press “d” to make
your Foreground color black,
then press Option-Delete
(PC: Alt-Backspace) to fill the
background with black.

In the project we’re

working on here, when we

set the type we increased

the amount of Horizontal

Scaling (the thickness of

the letters) by increasing

the Scaling amount to

130% in the Character

palette. But there’s

another way to edit the

Horizontal Scaling of your

image without typing

numbers in the Character

palette. Just set your type,

then press Command-T

(PC: Control-T) to bring up

Free Transform. Then click-

and-drag the right center

adjustment point (on the

Free Transform bounding

box) to the right. As you

do, it will stretch the type

(scaling it horizontally)

and will give you the

same effect as if you had

typed a percentage in the

Character palette in the

first place. This is a much

more visual way to scale

your type horizontally.

Quick Tip:
Horizontal scaling
without the palette
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If you’re creating custom

gradients and the colors

you need for your

gradient appear in the

image you currently have

open, you can really save

yourself some time when

changing the color of

existing Color Stops.

(Does that make any

sense? Well, read on, and

hopefully it will.) Here’s

how: Click on the Gradient

thumbnail (in the Options

Bar) to open the Gradient

Editor. Then, click on the

Color Stop you want to

edit (don’t double-click,

just click once), then move

your pointer out over

your image. Your pointer

immediately changes

into an Eyedropper tool

and you can sample a

color directly from that

image. Your Color Stop

will change to that

color—all without

opening the Color Picker.

Pretty neat! (Do people

still say “neat”?)

Quick Tip:
Saving time when
creating custom
gradients

STEP ONE: Open a new

document any size in RGB

mode. Click on the Type

tool and create some text

(I typed the letter “A” using

the Shelley Allegro Script

font from Adobe). Hold the

Command key (PC: Control

key) and click once on your

Type layer in the Layers palette

to put a selection around your

text (as shown).

Going for the Gold

STEP THREE: Go to the

Channels palette (under the

Window menu, choose

Channels) and click on Alpha 1

(as shown). Go under the Filter

menu, under Blur, and choose

Gaussian Blur. Enter 1 pixel and

click OK to apply a slight blur to

this channel. (For high-res

images try a 3-pixel blur. The

more blur, the wider the bevel

will appear later.)

This is a great technique for creating elegant gold type. Don’t be put off by the fact that

this technique uses Curves—what we do in Curves is so easy, even if you’ve never used Curves

before, you’ll have no trouble doing what you have to do here.

STEP TWO: Go under the

Select menu and choose Save

Selection to save your selection

as an Alpha Channel. When

the dialog appears, just click

OK. Press Command-D

(PC:  Control-D) to Deselect.

Now, delete your Type layer

by dragging it into the Trash

icon at the bottom of the

Layers palette.

continued
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STEP FOUR: Return to the

Layers palette and click once

on the Background layer to

make it active. Go under the

Filter menu, under Render, and

choose Lighting Effects. When

this dialog box appears, you

only have to make one small

change. At the bottom of the

palette, where you choose

the Texture Channel, choose

Alpha 1 from the pop-up menu,

and then click OK.

STEP FIVE: Go under the Image
menu, under Adjustments and
choose Curves. Create a curve
that looks like the one shown
here by clicking on the lower
left-hand side of the curve and
dragging upward. Release the
mouse button, then click on
the right-hand side and drag
downward. As you drag the
second point downward, you’ll
see the chrome effect start to
appear. When your curve looks
somewhat similar to the one
shown here, click OK.

STEP SIX: Go under the

Select menu and choose

Load Selection. When the

dialog appears, choose Alpha

1 from the Channel pop-up

menu and click OK. This

reloads a selection around

your type, but you’ll notice

it’s too small to encompass

the entire beveled type. Go
under the Select menu, under
Modify, and choose Expand.

The curve setting shown

in Step Five will do a good

job of producing metal,

but this is one area where

you can experiment and

have some fun. The curve

shown in this example has

just one hill, then it heads

back up. For a more

dynamic effect, try a curve

with two or three hills. The

more hills, the wilder it

gets. If your curve starts

introducing all sorts of

weird colors, don’t sweat

it. When you’re done with

your curve, press Shift-

Command-U (PC: Shift-

Control-U) to take all the

color out of your image,

leaving just the shiny

metal. The point is that

there are no “right”

curves; just move the

points until something

looks good to you.

Quick Tip:
Try different
curve settings for
different metallic
effects
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STEP NINE: Last, choose Color
Overlay from the Layer Styles
pop-up menu at the bottom
of the Layers palette. In the
dialog, change the Blend
Mode to Overlay, then click
on the Color Swatch and
choose a gold color (I used
this gold build of  R=208,

G=165, B=16). Click OK to

complete the effect. I added

some extra type to finish off

the project.

STEP SEVEN: When the
Expand dialog appears,
enter 3 and click OK to
expand your selection
by 3 pixels (if 3 is too much,
or too little, choose Undo
and try a higher or lower
number—the goal is to
select all the way to the
edge of the bevel).

STEP EIGHT: Press Shift-
Command-J (PC: Shift-
Control-J) to put your
selected type up on its own
layer. In the Layers palette,
click on the Background
layer to make it the active
layer. Press Command-A
(PC: Control-A) to Select
All, then press Delete
(PC: Backspace). Deselect
by pressing Command-D
(PC: Control-D). Click on
your text layer, choose Drop
Shadow from the Layer
Styles pop-up menu at the
bottom of the Layers palette,
and click OK.

If there's anything that

you want to turn into

chrome, there’s just one

trick you have to know

(besides the curve

shown): You’ve got to

bevel the object first.

The chrome won’t work

on a non-beveled object.

That’s why we use the

Lighting Effects filter on

a blurred channel—it

creates a beveled effect.

The rest is simple

enough—just draw a

hill in the curves window.

So, the next time you

want to turn something

into chrome, think first

about how to bevel or

emboss it, then think

chrome. Tip #1: The Bevel

and Emboss Inner Bevel

Layer Effect will usually

do the trick, but right

after you apply it, you

have to create a new

blank layer, drag it

below your beveled and

embossed layer, click on

your beveled layer, and

choose Merge Down

from the Layers palette’s

drop-down menu.

Otherwise, the chrome

curve interacts with

the live bevel effect and

it looks …well, bad.

Tip #2: Alien Skin’s

Inner Bevel plug-in from

their Eye Candy collection

also works like a charm.

Quick Tip:
The “make
anything
chrome” trick
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Terminator Titanium
This is a technique I’ve  been using for a while to create a metallic liquid titanium effect, similar to

the one used in the movie Terminator 2 (hence the name). I first picked up the technique from a

tutorial by Rick Hutchinson, from his Bright Ideas PDF-based magazine, and the technique shown

here is very similar, with just a few minor changes to make it easier.

STEP ONE: Create a new
document in RGB at 72 ppi.
Place the logo into your
document that you want to
convert to “Terminator
Titanium” so that it appears
on its own layer above the
Background layer. In the
example here, we used the
the letter “f” from Webdings.
(Note: this technique seems to
work best with images that
have a lot of solid black areas.)

STEP TWO: Hold the Com-
mand key (PC: Control key)
and in the Layers palette,
click on your Type layer (or
icon layer) to put a selection
around your image. When the
selection appears, go under
the Select menu and choose
Save Selection. When the
dialog box appears (shown
at right), click OK to save your
selection as a channel.

STEP THREE: Deselect by
pressing Command-D
(PC: Control-D). Go to the
Channels palette and you’ll
see a new channel named
Alpha 1 (as shown). Click
on this channel and press
Command-A (PC: Control-A)
to Select All, then press
Command-C (PC: Control-C)
to Copy this channel into your
Clipboard memory. Deselect
by pressing Command-D
(PC: Control-D).

Photoshop’s gradients

all have names and even

if you create your own,

you’re prompted to

create a name for it.

The problem is that the

Gradient Picker shows

thumbnails, so how

do you know which

gradient is which? There

are two quick ways

to make sure you’re

choosing the gradient

you’re looking for:

(1)  Go under the Edit

menu, under Prefer-

ences, and choose

General. In the General

Preference dialog box,

turn on the checkbox for

“Show Tool Tips.” With

this preference turned

on, if you rest your

pointer over a gradient

in the Gradient Picker, its

name will “pop-up” ; and

(2) You can change the

Gradient Picker to

display the gradient

names by choosing “Text

Only” from the Picker’s

drop-down menu.

However, the ideal

solution may be to

choose “Small

List” from the drop-

down menu, which

gives you a small

thumbnail followed by

the gradient’s name.

Quick Tip:
Finding out which
gradient is which
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STEP FOUR: Go to the Layers
palette, click on your icon
layer, then drag it into the
Trash icon to delete this layer.
Now, click on the New Layer
icon at the bottom of the
palette to create a new blank
layer. Press Command-V
(PC: Control-V) to paste the
channel held in your Clip-
board memory into this new
blank layer. Press Command-I
(PC: Control-I) to Inverse this
layer. (Your image should look
the one shown at left.)

STEP FIVE: Make a copy of this
layer by dragging it to the New
Layer icon at the bottom of
the Layers palette. Lower the
Opacity of this copied layer
to 40%. Press Command-A
(PC: Control-A) to Select All,
then go under the Edit menu,
under Transform, and choose
Flip Horizontal. Deselect
by pressing Command-D
(PC: Control-D).

STEP SIX: Once your image is
flipped, go under the Filter
menu, under Blur, and choose
Gaussian Blur. Enter 6 (try 12
for high-res, 300-ppi images)
and click OK to apply a blur to
your flipped layer. Then press
Command-I (PC: Control-I) to
invert your layer.

There are times when it’s

better to Merge Visible

(which combines all

visible layers into one new

layer) rather than simply

merging down. The main

reason you’d want to

Merge Visible, rather than

Merge Down, is that by

merging Visible you retain

the way the image looks

at the current time (i.e.,

as the layers collapse into

one another, the Blend

Modes don’t change).

However, if you Merge

Down one layer at a time,

the new layer takes the

Blend Mode of the lower

layer. This means that if

you used Blend Modes,

your image may look very

different each time you

Merge Down. So, if you’re

using any Blend Modes

at all, you’re better off to

hide any layers you don’t

want affected, then

choose Merge Visible

from the Layers palette’s

pop-down menu.

Quick Tip:
When to Merge
Down and when
to Merge Visible

continued
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STEP SEVEN: Go under the
Filter menu, under Distort, and
choose Wave. When the Wave
dialog box appears, lower the
Number of Generators to 2.
Lower the Wavelength Min. to
1, and set the Max. at 140. For
Amplitude use 1 and 12. Leave
all the other settings at their
defaults (as shown) and click
OK to apply this filter to your
blurred layer.

STEP EIGHT: Go to the Layers
palette, and click the Eye icon
next to the Background layer to
hide it from view. Then, in the
palette’s pop-down menu,
choose Merge Visible to merge
the other two layers into one.

STEP NINE: Go under the Filter
menu, under Sketch, and
choose Chrome. When the
dialog box appears, set the
Detail to 7, Smoothness to 7,
and click OK. Then press
Command-I (PC: Control-I) to
invert the image (as shown).

• To bring up the Gradient

Editor, switch to the

Gradient tool and in the

Options Bar up top, click

once on the Gradient

thumbnail.

• To add a new Color Stop

to your gradient, click

anywhere below the

Gradient Editor Bar.

• To remove a Color Stop,

click-and-drag downward.

• To edit the color of any

Color Stop, double-click

directly on the Color Stop.

• To change the Opacity

setting for the Gradient

tool, press the 1–9

number keys on your

keyboard (2=20%, 3=30%,

etc. ) while the Gradient

tool is selected.

• To step through the

Blend Modes in the

Gradient’s palette, press

Shift-+ while you have the

Gradient tool.

• To delete a gradient, hold

the Control key (PC: Right-

click) and in the Gradient

Picker or Editor click-and-

hold on the gradient you

want to delete, then

choose Delete Gradient

from the pop-up list.

Quick Tip:
Gradients
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STEP TEN: Remember that
Alpha Channel we created at
the beginning of this tutorial?
Now we’re going to put it to
use. Go under the Select menu
and choose Load Selection.
When the dialog box appears,
from the Channel pop-up
menu, choose Alpha 1, then
click OK to load this channel
as a selection.

STEP ELEVEN: Once the
selection appears on screen,
press Shift-Command-I (PC:
Shift-Control-I) to Invert the
selection. Next, press Delete
(PC: Backspace) to remove all
the excess area around your
icon, leaving you with just the
icon. You can now make the
Background layer visible
again by clicking in the first
column where the Eye icon
usually appears.

STEP TWELVE: Duplicate your
icon layer by dragging it to the
New Layer icon. Change the
Blend Mode of this copied
layer to Vivid Light (if you’re
still using version 6.0, use
Hard Light instead), then
lower the Opacity of this layer
to 50%. Press Command-E
(PC: Control-E) to merge these
two layers. Last, add a Drop
Shadow from the Layer Style
pop-up menu at the bottom
of the Layers palette.

If you need a metallic

gradient, you don’t

have to build one from

scratch—you’ve already

got a collection of cool

preset metallic gradients

just waiting for you to

load. Fortunately, loading

them into your flyout

Gradient Picker is a

breeze. Here’s how: First,

switch to the Gradient

tool, then, up in the

Options Bar, click on the

down-facing triangle

right next to the Gradient

thumbnail. This brings

up the Gradient Picker.

In the upper-right side

of this menu is a right-

facing triangle, which is a

pop-up menu. Click on it,

and at the bottom of the

menu, you’ll see a list of

gradient presets you can

load just by choosing

them from the menu.

To load the metallic

gradients, choose the

ones named “Metals”

from the pop-up list,

and Photoshop will ask if

you want to replace your

current gradients with

this set or append (add)

them to your current set.

It’s that easy.

Quick Tip:
Want some cool
metal gradients?
You’ve already
got ‘em!
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Reflective Chrome Gradient
This technique, a take-off on the chrome effects created by traditional airbrush artists, uses a

gradient that mimics the ground and the sky that would be reflected by real chrome. In this

example, we’ll create a custom gradient to simulate that style of chrome, but the gradient alone

isn’t enough—it’s the other elements that you add to it that give the impression of chrome.

STEP ONE: Create a new
document in RGB mode at
72 ppi. Press “d” to make black
your Foreground color, then
press Option-Delete (PC: Alt-
Backspace) to fill the Back-
ground layer with black. Add
a new blank layer by clicking
on the New Layer icon at the
bottom of the Layers palette.
Hide the black background by
clicking on the Eye icon in the
first column beside the
Background layer.

STEP TWO: Create the shape
you want for your metal
console. In this example,
I changed the Foreground
color to gray and used the
Rounded Rectangle tool to
create, well…a rounded
rectangle (as shown at right).

STEP THREE: Next, switch
to  the Gradient tool and its
Options will appear up top in
the Options Bar. Click on the
Gradient thumbnail to bring
up the Gradient Editor. When
the Editor appears, click on
the third gradient from the
left on the top row (it’s the
Black to White gradient).

In the project we’re

working on here, we

create a custom gradient

to simulate the chrome

effect used by traditional

airbrush artists. One of

Photoshop’s default

gradients has a somewhat

similar chrome gradient,

and it shares a common

problem with the custom

gradient we created—its

“horizon line” is perfectly

straight. Most airbrush

artists vary this horizon

line slightly to make the

gradient look more

natural. You can do the

same thing in Photoshop

(vary the horizon line) by

using Photoshop’s Wave

filter (found under the

Distort submenu). Use this

filter to create a slight

rolling effect along the

horizon line. A good place

to start is to lower the

Number of Generators

to 1. Set the Wave Length

Min. to 1 and Max to 100.

Set the Amplitude to 1

and 6, and click OK, This

should add a slight roll to

your horizon line.

Quick Tip:
Bending the
horizon of the
Chrome gradient
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STEP FOUR: We’re going to
create our own custom
gradient using the Black to
White gradient as a starting
point. First, double-click on the
far left-hand side Color Stop,
located directly below the
Gradient Editor Bar. This brings
up the Color Picker prompting
you to “Select stop color.” In
the RGB fields, enter: R=164,
G=175, B=184 to set this first
stop to a light “sky” blue.
Click OK.

STEP FIVE: Next, slide the far
right Color Stop over to the
center of the Gradient Editor
Bar. Double-click on it to set its
color. This time in the RGB
fields, enter: R=226, G=227,
B=226 to set this middle stop
to an almost white color.
Click OK.

STEP SIX: Click immediately to
the right of your middle Color
Stop under the Gradient Editor
Bar to add a new gradient
Stop. Slide this Stop almost
right up against the middle
Stop. Double-click on this new
Stop to set its color. In the RGB
fields, enter R=78, G=73, B=67
to set this new stop to a
brownish color. Click OK.

When you’re creating

custom gradients, you

always have to start with a

gradient (by that I mean,

when you open the

Gradient Editor, it opens

with a gradient already

loaded into the editor).

This is weird because it

works in about exactly the

opposite way you’d think

it would. You’d imagine

you’d click the “New”

button, and it would give

you some default starting

point, but it doesn’t.

Instead, it works like

this—you open the Editor,

the last gradient you used

is already there waiting to

be edited, and when it

looks the way you want it

to, you put a name in the

Name field, and only then

do you click the “New”

button. (I know, it’s weird

but that’s the way it

works.) So which gradient

should you use? Who

knows for sure, but I

always start by clicking on

the third default icon in

the top row. It’s the Black

to White gradient, which is

easier to edit than the

Foreground to Back-

ground gradient (the first

in the list) for a variety of

reasons that I don’t have

the space to explain here.

Just trust me, give the

“edit the Black to White

gradient” thing a try.

Quick Tip:
Which gradient
should you edit?

continued
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STEP SEVEN: We’re going to
add two more Stops: One
halfway between the middle
and the end (set to R=224,
G=221, B=87 for a beige) and
then one at the very right-end
of the Gradient Editor Bar (set
to R=226, G=225, B=198 for a
very light, almost white stop).
Your gradient should look like
the one shown at right. Name
this gradient “metal sky” and
click the New button. Press OK
to save it.

STEP EIGHT: Now we add the
fluff stuff that helps sell the
effect. Hold the Command key
(PC: Control key) and in the
Layers palette click on the
layer with your rounded
rectangle to put a selection
around it. Then, go under the
Select menu, under Modify,
and choose Contract. Enter 6
pixels and click OK to shrink
your selection by six pixels.
Grab the Gradient tool, and
drag it from the top of your
selection to the bottom (as
shown at right).

STEP NINE: While your
selection is still in place, add a
new blank layer above your
current layer by clicking on
the New Layer icon at the
bottom of the Layers palette.
Go under the Edit menu and
choose Stroke. When the
Stroke dialog box appears,
make sure the stroke color is
set to black, and enter 2 pixels
for the stroke Width. Set your
Location to Center and click
OK to apply a 2-pixel stroke
around your selection. Don’t
Deselect yet.

That’s right, don’t use

that Delete button in the

Gradient Editor dialog

box. Well, you can use it

if you’re charging by the

hour, but outside of that,

it’s much faster to click

on the gradient you

want to delete and

drag downward. It will

immediately disappear

(become “deleted").

Quick Tip:
Don’t use the
Delete button
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STEP TEN: Now switch to the
Line tool (it’s one of the Shape
tools in the Toolbox). When
you get the Line tool, up in the
Options Bar, click on the third
icon from the left to enable
you to draw just lines, without
adding a special shape layer.
We’re going to visually divide
our console using lines, so
create the lines shown at left.
Since the selection is still in
place, you can drag past the
borders, but the lines will stop
at the edge of your selection.

STEP ELEVEN: Deselect by
pressing Command-D (PC:
Control-D). Make a duplicate
of this Line layer by dragging
it to the New Layer icon in the
Layers palette. Press “d” then “x”
to set white as your Foreground
color. Press Shift-Option-Delete
(PC: Shift-Alt-Backspace) to fill
your lines with white. Press “v”
to switch to the Move tool, then
press the Right Arrow key once
and the Down Arrow key once
to offset your white lines from
your black lines, giving the
impression of an indentation.

STEP TWELVE: Make your black
Background layer visible again
(click where the Eye icon used
to be). Click on the gradient
layer, and add a Bevel and
Emboss Layer Style with the
Depth set to 300%, and lower
the Shadow opacity to 33%.
Last, create a new blank layer
on top. Get the Polygon tool,
set its Sides to 3 (in the Options
Bar) and use it to add naviga-
tion buttons (as shown).
To give the buttons the
“sunken-in” look, add a Bevel
and Emboss, but change the
Style to Pillow Emboss.

Each tool in Photoshop

has its own set of Options,

and chances are that

you’re going to be

constantly changing

them. For example, in Step

10 of this project, you’re

changing the option for

the Line tool. You never

have to worry about

messing these tool

options up, because

you’re always just one

click away from resetting

the tool to its default

settings. Up in the

Options Bar, on the far left

side of the bar, Control-

click (PC: Right-click) once

on the icon for the tool

you’re using. Choose Reset

Tool from the pop-up

menu and that resets the

tool to its default settings

so you can play to your

heart’s content.

Quick Tip:
Getting back to
the tool’s default
settings
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Liquid Metal
This time we’re using a filter to create the metallic effect, instead of embossing and using
Curves to create the look. We use the Find Edges filter to create the highlight and shadow
areas of our metal to give us a more rounded liquid style effect as opposed to the hard
metal most traditional methods create.

STEP ONE: Open a new
document in RGB mode at
72 ppi. Create some large
bold type.

STEP TWO: Go to the Layers
palette, hold the Command
key (PC: Control key), and click
once on your Type layer’s
name to put a selection
around it.

STEP THREE: Go under the
Select menu and choose Save
Selection. When the dialog
box appears, click OK to save
your selection as an Alpha
Channel. Now that you’ve
saved it, you can Deselect by
pressing Command-D and in
the Layers palette, drag the
Type channel into the Trash at
the bottom of the palette to
delete it.

In Step Two in the

example shown at right,

I have you hold down

the Command key (PC:

Control key) and click

on the layer. This puts

a selection around

everything on the layer

(in this instance, it’s a Type

layer, so it puts a selection

around your type). What

you’re doing (in technical

terms) is loading the

layer’s transparency

(which you can do

manually by going under

the Select menu, choosing

Load Selection, and then

choosing to load the

channel named “transpar-

ency”). What most people

do who need to put a

selection around their

type, but don’t know this

trick, is use the Magic

Wand tool to select each

letter individually. It

works—it does put a

selection around the

type—but if you move

that type, it leaves little

specs (well, pixels) behind

that the Magic Wand

misses. The advantage

of loading the transpar-

ency instead is that it

doesn’t leave any little

stray pixels behind. That’s

why we always choose

to load transparency.

Quick Tip:
The advantage of
loading the layer’s
transparency
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STEP FOUR: Go to the
Channels palette and click on
Alpha 1. Make a copy of this
channel by dragging it to the
New Channel icon at the
bottom of the Channels
palette. This creates a new
channel called Alpha 1 copy.

STEP FIVE: Go under the Filter
menu, under Blur, and choose
Gaussian Blur. For Radius enter
3 and click OK. Hold the
Command key (PC: Control key)
and click once on Alpha 1 copy
to put a selection around the
type. Go under the Filter menu,
under Blur, and choose
Gaussian Blur. This time for
Radius, enter 6 and click OK to
blur the inside of the type. Now
go to the Layers palette, and
click once on the Background
layer. Don’t deselect yet.

STEP SIX: Go under the Filter
menu, under Render, and
choose Lighting Effects. In the
Light Type pop-up menu,
choose Directional. You only
have to make a couple of other
changes here: Under Proper-
ties, set the Gloss to 100
(Shiny), set the Material to
–100 (Plastic), then skip down
to the Texture Channel and
choose Alpha 1 copy from the
pop-up menu. Click OK.

This is a follow-up to the

tip on the opposite page,

where we showed the

advantage of loading a

layer’s transparency to put

a selection around any

object on the current

layer. You do that by

holding the Command

key (PC: Control key) and

clicking on the layer’s

name in the Layers

palette. Well, you can do

the same thing in the

Channels palette—you

can load the Alpha

Channel as a selection by

holding the Command

key (PC: Control key) and

clicking on the Alpha

Channel you want to load,

and it will instantly load as

a selection.

Quick Tip:
You can load
Channels just
like a layer’s
transparency

continued
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STEP EIGHT: While your
selection is still in place, press
Shift-Command-J (PC: Shift-
Control-J) to put your selected
area on its own layer. Then, go
under the Filter menu, under
Sharpen, and choose Unsharp
Mask. For Amount choose
200%, for Radius choose 1,  for
Threshold choose 15, and click
OK to enhance the metallic
look. Next, choose Drop
Shadow from the Layer Style
pop-up menu at the bottom
of the Layers palette and click
OK. Last, go under the Image
menu, under Adjustments, and
choose Hue/Saturation. Click
the Colorize button, then drag
the Hue slider over to 214 and
lower the Saturation to 20 to
complete the effect.

STEP SEVEN: Don’t Deselect
yet. Go under the Filter menu,
under Stylize, and choose Find
Edges to begin bringing in the
liquid metallic look. Deselect
by pressing Command-D (PC:
Control-D). Now go under the
Select menu and choose Load
Selection. When the dialog box
appears, choose Alpha 1 (your
clean type channel) from the
pop-up menu, and click OK to
load that as a selection. Press
Shift-Command-I (PC: Shift-
Control-I) to Inverse your
selection, and then press Delete
(PC: Backspace) to delete the
background area, cleaning up
your edges. Then press Shift-
Command-I (PC: Shift-Control-I)
to reselect your type.

In the project at right, we

use the Find Edges filter.

Another thing I often use

the Find Edges filter for is

converting a photograph

into a line drawing. Just

apply the Find Edges filter

and it does a pretty nice

job of tracing the edges

of your photo. It does

create a slight problem in

that it often introduces a

number of weird colors

to the resulting line art,

but all you have to do

is go under the Image

menu, under Adjustment,

and choose Desaturate

to remove the extra colors

and return it to a black

and white line drawing.

Quick Tip:
Another use
for the Find
Edges filter
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Drop Shadow  171
Duplicate  35
Duplicating objects  172

E

Edit menu  16, 116
Define Pattern  135, 173
Fade  16
Paste Into  259
Stroke  115, 126, 156

Eliminating backgrounds  208
Elliptical Marquee tool  145,  181

circular selections  232
Embedding Objects  210
Eraser tool  71, 173
Escape dialog box  179
Euro collage  230,  238
Extract  94

Extract tool shortcut  220
Extras  163, 187
Eye Candy  247
Eyedropper tool  79,  256

Color Sampler Eyedropper  209
Sample Size  64

www.downanddirtytricks.com


Guides  83
Clear Guides  181
New Guide  157

H

History  75, 138
History Brush  71
History Eraser  71
Horizontal scaling  116
Hue/Saturation  57, 93, 95, 100, 108

Colorize  99
Hue/Saturation  65
Hyperspace  268

I

Image menu  17
Canvas Size  17

Image Size  136, 156
Info bar  57

Current Tool  57
Info palette  76, 105, 238

Color Sampler Eyedropper  209
Palette shortcut  209

Inner Shadow  107, 114, 158
Invert  30
Invert the selection  123

J

jaggies  140

K

Kost, Julieanne   191

L

Lasso tool  168
Layer Mask  68, 69, 98, 261

Layer Mask icon  31
Layer menu  17

Add Layer Mask  17
Reveal Selection  17

Create Work Path  181
Defringe  55
Group with Previous  54
Layer Styles pop-up menu  54
Matting  55

Defringe  55, 95
Layer Styles  9, 10, 31, 92, 245

Angle  212
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F

Fade  16, 74
Feather  50, 67, 82, 85, 111,  186,  201
File Browser  253

Batch Ranking  191
Rank  191

Fill  28, 90, 135, 148, 216
Fill Dialog shortcut  90
Fill shortcuts  115
Pattern  135, 231
Pattern Picker  148, 173, 231
Color Blend Mode  221

Filter menu  16
Brush Strokes

Spatter  75
Distort  41

Displace  60
Extract  94
Lighting Effects  74
Pixelate  16

Color Halftone  141
Fragment  56
Mezzotint  16

Render  74
Filters  16, 29, 39

3D Transform  264
Add Noise  38
Bring up the last filter dialog box  8
Chrome  122
Clouds  74, 217
Color Halftone  141
Difference Clouds  217
Displace  60
Distort

Ripple  267
Emboss  191
Extract  94

Extract tool shortcut  220
Find Edges  130
Fragment  56
Glass filter  41
Lens Flare  269
Lighting Effects  74, 129

Lighting Effects tips  215
Mezzotint  16
Motion Blur  38
on CMYK images  239
Pixelate  141
Plastic Wrap  247
Polar Coordinates  28
Previews  39
Radial  33
Radial Blur  31

Zoom Blur  31, 33
Render

3D Transform  264
Repeating filters  165
Ripple  267
Shear  87, 158, 216
Sketch

Chrome  248
Halftone Pattern  258

Solarize  28
Spatter  75
Sprayed Strokes  39
Unsharp Mask  22, 38, 113, 130, 161
Wave  122

Find Edges  260
Flames  155
Free Transform  25, 48, 81, 139, 152

corner points  161
Escape  49
Flip Horizontal  25, 121
Flip Vertical  48
Perspective  18,  48
Resizing layers  141
Scale  25
Skew  25

G

Gaussian Blur  28, 88, 247, 270
Gel Type  21
GIF89a  61
Glassy Reflections  142
Glints  114
Gloss Contour  106
Gold  117
Gradient Picker  107, 120, 144,  227

Gradient Picker shortcut  228
Gradients  8, 122

Chrome gradient  107, 124
Copper gradient  228
Foreground to Transparent gradient

146, 186
Gradient Editor  8, 37, 117, 124–125,

149
Color Stop  8, 117
Delete button in Gradient Editor  126
Copper gradient  214
Foreground to Transparent gradient
232

metal gradients  123,  212
Radial Gradient  38, 217, 232
Transparent Gradients  226

Grayscale 65, 99,   254
Grouping Shadows  54
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Bevel and Emboss  150
Chisel Hard  33, 106
contours  104
Gloss Contour  105
Stroke Emboss  35
Color Overlay  34, 176, 189, 221

Copy Layer Style  245
Deleting Layer Styles  31
Detaching a Layer Style from layer  243
Drop Shadow  9
Glow  10
Hiding  31
Inner Glow  42
Inner Shadow  33
Outer Glow  61, 244
Paste Layer Style  245
Paste Layer Style to Linked  135
Satin  37
Stroke  37
Style Presets  42
Use Global Light  36

Layers
Adjustment Layer  75
Aligning objects  182
Background layer  171
Clipping group  26,  243
Create Layer  243
Creating new layers  162
Dragging layers between documents  56
Duplicating  32,  52
Hiding the Background layer  97
Layer Mask icon  35
Layer Properties  188
Layer Sets

New Set from Linked  213
Layer via Cut  50
loading the layer’s transparency  128
Merge Down  121, 185
Merging Visible  70
Moving layers  19
Moving to another document  246
Naming layers  184
new layer underneath  82
opacity  27
Resizing multiple layers  141
shape layer  14
Type layers  143
Unlinking Layers  96
Viewing only active  244

Layers palette  52, 164
Adjustment Layer  75
Adjustment Layer pop-up menu  108
Background layer  171
Copy Layer Style  135

Fill  180
Fill slider  189
Lock Transparent Pixels  52, 150, 191
Merge Visible  121, 154
Merging Visible  70
Opacity  73

Levels  30, 34, 72
Auto Levels  28
Input Levels  201
Levels tip  222
Output Levels  83, 159, 222

Lighting Effects  118, 203
Lighting Effects tips  215
Texture Channel  118

lightning  241
Line art  254,   260

Colorizing  254
Colorizing with gradients  255

Liquid Metal  128
Liquify  258, 267
Load Selection  123

M

Matting
edge pixels  160

measurement units  94
Merge Down  121
Merge Visible  97, 121
Metallic Glass  246
Modify  21

Contract  151
Motion Blur  46, 70, 92, 180, 229
Moving Shapes  93
Multicolor Glow  244

N

National Association of Photoshop
Professionals  155

Navigating  67
Navigator palette  67

navigation shortcuts  66
Nelson, Felix

34, 86, 89, 94, 155, 157, 256
New Set from Linked  213
Nikon Coolpix 990  91, 94
Nudging layers  178

O

Opacity  73
Moving sliders  189

Options Bar  149, 223

Custom Shape Picker  188
Gradient thumbnail  38
Radial Gradient  38
Warp Text  137

Outer Glow  61, 81

P

Palettes  11
Actions palette  51
Character palette  13
dealing with clutter  11
hiding from view  250
Info palette  76
palette thumbnails  98
Paragraph palette  84
Paths palette  184
Styles palette  42, 92, 189

Paragraph palette
paragraph attributes  84

Paste Layer Style to Linked  135
Paths  168

Clipping Paths  26
Direct Selection tool  169
hide a path  97
Stroking Path shortcut  205
Turning into a selection  168

Paths palette
Make Selection  168
Stroke Path  208

Patterns  135
Presets  266

Pen tools  26, 170,   200
Add Anchor Point tool  170

Pencil tool  147
Perspective blur  53
Photo to Line Art  260
Photoshop User magazine  110,  188
Photoshop WOW! Book  34
PhotoshopWorld  155
Pixelate  56
pixelation  58
Polar Coordinates  28
Portrait Background  84
Precise Cursor  142
Preferences  12

checkerboard pattern  175
file name extensions  225
General Preferences  12

Smart Quotes  95
Tool Tips  107

measurement units  94
Precise Cursor  142
Preferences windows  12
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Quick Mask  177
print work  28

Q

Quick Mask  66, 111, 140, 177

R

Radial Blur  92, 268
rasterize  15,  39
Rasterize Layer  46
rasterizing  47
Rectangular Marquee tool  72, 76
Remove Black Matte  160
Remove White Matte  160
Renaming brushes  195
resampling  58
Reselect  153
Resizing by the numbers  81
Revert  71
RGB  159
Ricoh  185
Ripped Edge  242
Rounded Rectangle tool

124, 149, 162, 212
Ruler Guides  46

S

Satin  37, 104, 106
Save for Web  61
Save Mesh

Liquify  267
Save Selection  117, 128, 200
Saving Files  78
Scan lines  148
scratches  80
Select menu  21

Inverse  39
Load Selection  17
Modify

Contract  126
Expand  119

Save Selection  117
Selections  16

Add to Selection  40
Changing the size of  216
circular selections  232
intersect  16
Invert the selection  123
Lasso tool  40
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Load Selection  17
Channel pop-up menu  91

Loading Selections  202,   234
marching ants  163
Moving from document to document

248
Polygonal Lasso  53
pop-up contextual menu  207
Reselect  153
Save Selection  117
Selecting just one letter  271
selection around your type  21

selections  50, 76, 77, 153, 174
Save Selection  174

Shape
Rasterize  205

Shape layer  188
Shape tools  93

Custom Shape Picker  188
Custom Shape tool  204
Line tool  127
Polygon tool  205
Rounded Rectangle tool  124, 149

Shapes
Moving Shapes  93
Presets  266

Shear  87, 158
small type  87
Smart Quotes  95
Spatter  75
Spell Checking  259
Spot Color

DCS 2.0  238
Spot colors

New Spot Channel  238
spot colors  238
Spotlight Effect  185
Sprayed Strokes  75
Starbrights  153
steel bars  214
steel rivets  226
Straight Lines  86
Stroke  8
Styles palette  59, 92

T

Tattoos  86
Ted LoCascio  94
Textures  206
Threshold  269, 271
Tool Tips  107

Toolbar
Pen tools  170

Toolbox  34
History Brush  71
Line tool  14

Tools  134
Art History Brush  256
Background Eraser tool  208
Blend Modes  192
Blur tool  80
Brush tool  257
Crop tool  112
Direct Selection tool  169, 183
Elliptical Marquee  145,  181,  217
Eraser tool  71, 156
Eyedropper tool  64
Gradient tool  66
Lasso tool  40
Line tool  127, 212
Magic Wand  39, 128
Paint Bucket tool  220
Pencil tool  147, 215
Polygonal Lasso  53, 142, 262
Rectangular Marquee tool  72
Rounded Rectangle tool  124
tool default settings  127
Type Mask tool  14
Type tool  34
Zoom tool  66

TV scan lines  135, 147, 258
Type  18, 46

aligning type  211
Anti-aliasing

Sharp  87
Character palette  13

Tracking  36
Convert to Shape  18
Faux Bold  137
Faux Italic  137
fonts  252
Kerning  32
Rasterize  28
rasterize  18
symbols  24
Text Warp  23
Tracking  13,  98
Type layers  143
Type Mask tool  14
Type tool  34
Warp Text  137

type  28
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Window menu
Documents

New Window  159
Wire Frame  262
Wood Type  38

Z

Zoom  20,  146
zooming in close  251

Zoom tool  66

View menu
100% view  20
Clear Guides  181
Extras  163

W

Wacom tablet  194
Water Drops  270
Wave  122
Web browsers  151
Webdings  110

U

undo  138
units of measurement  105
Unlinking Layers  96
Unsharp Mask  22, 113, 161, 229, 249

V

Vector Masks  155
View  240

Extras  163
view  85, 139, 140

I N D E X

F O N T  L I S T I N G

CHAPTER 1
Page 8: Impact

Page 11: Adobe Garamond Cond. Light

Page 13: Optima

Page 16: Futura Extra Bold
(type in poster: Adobe Garamond

Condensed)

Page 18: Futura Extra Bold

Page 24: Compacta Bold

Page 28: Futura Extra Bold

Page 32: Compacta Bold

Page 36: Gil Sans Ultra

Page 39: Friz Quadrata

Page 41: Trajan

CHAPTER 2
Page 46: Trajan

Page 48: Times New Roman
(Horiz condensed in Character palette)

Page 56: Minion

Page 58: Trajan

Page 61: Trajan (130% Horiztonal Scaling)

CHAPTER 3
Page 73: Myriad Regular

Page 81
Adobe Garamond Condensed Bold &
Adobe Garamond Condensed Light Italic

Page 83
Adobe Garamond Condensed Light Italic &
Adobe Garamond Condensed Light

Page 85: Bureau Agency

Page 98: Minion &  Bodega Serif

CHAPTER 4
Page 104: Rapier

Page 107: Styleboy

Page 110: Webdings

Page 114: Aachen Bold

Page 117: Shelley Allegro Script

Page 120: Webdings

Page 128: Bullet Small Caps

CHAPTER 5
Page 137: Compacta Bold

Page 142: Helvetica Ultra Compressed

Page 152: Myriad Regular

Page 157: Trajan

Page 165: Myriad Regular

CHAPTER 6
Page 173: Banshee
Smaller type: Times

Page 174: Adobe Garamond Condensed
       Light

Page 181: Aachen Bold

Page 184: Kauffman Bold Italic

Page 187: Playbill

Page 189: Helvetica Regular

Page 190: Angry Hog ITC

CHAPTER 7
Page 203: Helvetica (anti-aliased at Sharp)

Page 205: Compacta Bold

Page 210: LCD Plain

CHAPTER 8
Page 240: Helvetica Ultra Compressed

Page 244: Bullet

Page 246: Myriad Regular

Page 252: Trajan (numbers in OCRA)
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